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1. 7593, 50 WA & g ue- g & e it g s adyr S s 01 Hour 81
The Quéstion paperisin the form of Question:Booklet with. 50°questions-and the duration of the test is
1 Hour.

2. IR faedi wiea aRgg W & o G o & i oo anifim e & W Fvm
The questions will be objective type with four options. out of which only onie will be unambiguously

gorrect.

3. S W R 03 i gHY afie el e e 3 PN o 3fep SR IO |

Each question carries 03 marks and one mark will be deducted for-each wrong answer.

4. Tt o T 37 % oI e siiqre sx-yfee Stemeh

A separate OMR answer sheet with carbon coated copy will be provided to mark the answer options,

5. @], IS H Y g argdRit % snpae, el / it v 8 wfe vive ¥ § siurem so-ufRie & wafee
ST Y Sifehy T T I B T FEATR
You have to select the right answer by marking the corresponding oval.on the OMR answer sheet by

blue/black ball-point pen as per instructions given in the answer sheet,

6. T 0 & oY oier ST TIere WA STIgem |

Multiple answers for one question will be regarded as a wrong answer.




7. P41 X nt T S S ieh W fer |

Enter your Name-and Roll Number correctly in the question booklet.

8. sita Fe-ufRe! i vt eft / et wrd & s dige I A @ o TRy
.All enitries in the:OMR sheet should be with blue/black ball pott pen only.

9. e aer & Pifteye o sufeafa B & s Sufefe e o ERmE e Al |

You should sign attendance sheet only in the presence of the Invigilator in the examination hall.

10, Fife ity Sier S ofte ST, SR, HIATSE B9 6T gR O, T gei, JE 3 W 5
ST R & ST
Computers, calculators; mobile phones and other electronic gadgets, text books, notes etc. will notbe

allowed inside the written test hall.

11, Thigr T ST, Hgfaﬁr{qam wg@wﬁﬁmaﬁﬁﬁ o gEd i (R 47 )ere U T |
On completion of the test, original OMRanswer sheet 1o the invigtlator and retain the duplicate copy

(Yellow color) with you.

12, W it i |

Return the question booklet to invigilator.

13, e ¥ R it e e Bied Y ergAf Tl €

Candidates are not permitted {0 leave the examination hall-during the examination.
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. A AaR T v T OeR FH 2

Which of the following memories has the shortest access times?
A, Aot fEe gwer AFRT/Magnetic bubble memory
B. %ﬁ!’ﬂ?ﬂﬂ /Cache Memory
C. Heaifes &R AANT /Magnetic core memory

D. W /RAM

2. ek mmmﬁwmchpum & e aﬁqm%o
‘Which among the following hardware you u‘su&lly-c‘an“’r'ﬁhd inside a CPU
Casing?

A.  OTEX GEATS SiEE/Power Supply box-
B. difsat w8 Ni;ieo card

C.  WfFY WHFT /Graphics processor
D. dRgrEee AT /Video display unit

T HRFET Reen 39el For AN =1 gl & s firremsy S P
All Operating Systems get their total memory initialized from?

A.  ErMg/cPU
B. T /BIOS

L

C. QA/ROM

D.  PRAM




s R 8 e e o eh Ry AR 71 TR AT
Windows stores all system-'setﬁn'g_s"in-\ihhich ofthe following files?

A. MAIN.INI

B. SYSTEM.INI

¢, SETTING,INI

D. WIN.INI

T "CEERT’ #1 {18 i #1 17 3K 579 it @ ger & o B F TS
a7 ST fT AT R

Which command-is nsed to remove the read permi'ssio_n of the file CEERI"
from both the group and others?

A. chmod go+r CEERI

B.. chmod got+rw CEERI

C. ¢hmod.go-r CEERI

D. chmod go-x CEERI

Wﬁmmmwmmﬁﬁmm%ﬂ
Which feature of Microsoft Word helps in creating a list?
A @E}T 5 =99 /Bullets and Numbering

B. E’éé‘q /Word Wrap

C. EHTda/Sealing

D. & HE/Word Art

Gutter margin refers to?

A afds s fRiT m.mﬁsf%-aéﬁﬁ'mﬁ-ﬁmstm‘%margimhm is
added to the binding side of page when printing
B, AT o i ST Ba a7e AifSiA # 09T A § /Margin that is added to
the left margin when printing
C. S = g F TR 55 & a8l =1 STET ¥ /Margin that is added to
the outside of the page when printing
D. A TS o T #7a §o & ATfera SiYET AT & /Margin that is
added to right margin when printing

2



10.

g A% 1T Header 3R Footer 5vE FLTFAE ?

From which menu you can insert Hedder and Footer?
AL BTHE ﬁiﬂnscrt Menu

B. E’-{\ﬁﬁ'\N tew Menu

C. e ﬁﬁ'\_!Formaf menu

D. gl ﬁ?g_;'r.onl;é Meni

Document Qutline View 'ﬁﬂ%"
What is.a Document OQutline View?

A, TEHFQO A wqgﬁ'q'a‘ﬁmm preview in a full screen

B. Faffiesr waRi T ofiie Y GTae & TTY T T9F /A view with a structure
of heading at various levels

C. AT & AT OF qaTaa1Fa /A preview with margins

D. AT 3T 7CT & T TF T /A View with a margins and gutter

You can use the formula palette to
A. BIHE BoH Hefar #av/Format cells containing numbers
B. =¥ aﬁm@a‘r & EI?{TQ'UBﬁT 'ﬂ'qlﬁ?faﬁ' /Create and edit formulas

containing functions

C. YRUIT 3T &ot &1 /Enter ass umptions data

D. FAT &7 3iTH T /Copy a range of cells
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T4,

g ITE S ST T FRUEEH TG grHEH et 3 e &

The chart that shows the data in tabulaxr formor in column pat’tern.

A, 7T 91€ /Area Chart
B. S’Fifﬂ'l'& /Doughnut Chart
C. SR qe/Column Chart

D. mmﬁ /Bar chart

stor 7 ST A 3 Rt a3 oS A qEw FAR & §?
‘What dialog box allows you to change a field name in 2 Pivo’t'T-abie?

A Hros Ao/ Field Options

B. e I+ [Field Pane

¢. $res A /Field Settings

p. WTes TgFaU/Field Structure

In Excel, how will you graphically represent ekpenditureincur_r_ed in

different departments?

A. 9§ ATE/Pie Chart

B. HIEA A¢/Column Chart
C. &g TiE /Line Chart

D. 2fc ATEMot Chart

VS EXCEL &1 &3 T therrer o o1 #gd) 1 qlt & Rears o yfeeataa

“Which function of MS EXCEL evaluates an .ex_pr.es_s_ion. against a list of values

in order, and returns the first'mat'ch'ing'rESulf?
A, MATCH
3. SWITCH

L. IF§

D. TEXTJOIN



] 6‘-’

BreaTaTRd # & Fis 61 MS EXCEL & A% 514 w7g1 §7

Which of the following is not a valid function in MS EXCEL?

A. SUMQ

B. SUBTRACT()

C. COUNTQ

D. COUNTAQ

rrataiaa TioTdr yfeatradt ot Tare F agee & vy ey

ST IYT BT AT 87
‘Which option/feature is used to convert handwritten mathematical

expressions to text?

A. EEATRTAT to BFEC/Handwritten to Text
B. WsTEr to ETFTT/Writing to Text

C. 9% to EHFEC /Pen'to Text

D. §% to2FEE/Ink to Text

Correct steps to protect a, PowerPoint presentation with a password?-

A. T8 > TEFT Teee > vivsete Ry araad
Tools -> Protect Presentation -> E-ncryf_;t with password
B. WIge ->3eH] > Teae Foled -> vfewve @y gred
File -> Info -> Protect Presentation -> Encrypt with password
C. BEd > AR AR -> e Joiee > vhww by oad

File -> More Options -> Protect Presentation -> Encrypt with pagsword.

D. SRiFT e @eea/Ail of the above




0.

aﬁsf1¢fazL3Tn:%;z%qjﬁ'éé#ﬁar;rﬁiiftﬁﬁr,iﬁr,Fﬁ?ﬁ;f%:ﬂTsE;aﬂﬁ%fé?ﬁyﬁ?ﬁﬁ
Which view controls the look of you rentive presentation such as {onts, colors,
logos; designs, etc;

A. FOTSS ATEEI /Slide Master View

1. Es3TsE AECR & /Handout Master View

¢. =gy FRET of/Notes Master View

b, 3qET Fwedl 3 & 1§ T8/None of the above

Whieh option/feature is used to-avoid showing all of the elements of a slide af

once?
A. 5783 TWTgS/Hide slide
B. oo 3iT® TR /Turn off animations

. ez TATSE /Build slide

D. aﬁaq:ﬂg /Normal view mode

Sord @ e AT ViySQL ¥ T AT e

Which of the following:is an aggregate function in MySQL?
A, LIKE
B. LNION

D, GROUP BY



21,

22.

23.

MySQL TTHE (USE student;} # student s gifafeg sxar i

In the MySQL:statement (USE student;), what does student represent?

A. ROW &7 & /ROW name
B: Database FT s1T# / Database name
C. Table ST ATHA/Table name:

D. Column & FA/Colunin name

AT ol _ii'i._ @ ﬁ?m + 313'\" student_name 3k student. department s7H & &7

D=4 §, at 319 &7 g7 i

Suppose you have tweo columns named student name and
student_department inside table student_details and you are asked to update.
the value of these two columns where D=4 then what statement you will

‘write?

A. UPDATE student_details SET Studerit_name="ram",
Stud en't_-departmén.t‘:‘C hemical' WHERE ID="4";

B. UPDATE table student_details SET column_name
‘Student_name="ram", Student_department='Chemical' WHERE ID="4';

C. UPDATE student details SET Student name="ram" and
Student_department="Chemical' WHERFE [D="4":

D. 39ed Reeaiw g ﬁé’ﬁ'ﬁﬁ/ﬂane of the above

DHCP ®&T I 37 5=t & v fvw upp 9 dax &1 3wt s 2

‘DHCP uses which UDP port number for sending data to the server?

A. 67

‘B. 66

C. 68
D. 69




b-2.
ih

A QT Aearnst %Elsir FA WIS T ST S TF LAN S GACLAN
FAEATE?

Which networking device connects one LAN fo-another LLAN using the same
prot‘oéoi.‘?

A. TFHEL [Router

3. Teaa/Switch

. &=/Bridge

D. HEH/ Modem

v # e o R T R 3 g 1 el A S
%?

‘Which of the following tools is used to restore corrupted Exchange Server
Database files as-well as recovering inapproachable mails.in the mailboxes?

A. FTSCE®/OQuilook
B, ﬁ'{ﬁ'&f’?é;essus
¢, Foaten TFEas Readl /Mailbox Exchange Recovery

5. &or rEEHe NEal ?E.\—m'ﬁi‘c' /Mail Exchange Recovery toolkit

STAFATEl

Devices on one network can be connected with devices on other networks via

a.

A. TS Fa /File Server
B. g FET /Utility Server

C. fex 'Hé.‘{f}?rinter‘--Server

. AEd/Gateway



27

28.

css #, agd e e 3 defla F & fov efaRa A & wm @
Riter v

In CSS, which of the following is the correct syntax for referring to the

external:style sheet?

<gtyle src = example.css>
<style src = "example.css" >

<stylesheet> example.css </stylesheet>

o 0w >

<link rel="stylesheet" type="text/css" href="example.css'>

css ¥ Brtafaa # ¢ w9 v tew e R gt & deaEsset A
ot s & v ad Rt 32

In CSS, which of the following is-the correct syntax to make the-hackg__rﬁund.—-

color of all paragraph elements to yellow?

p {background-color : yellow;}

p {"bac_-kgrojund'-colo'r 1 #yellow;}

0w p

. all {background-color : yellow;}

all p {background-color : #yellow;}

css &, Prefafla # & wia o sfed! Pffee st & 75 Bt aea 1
In €88, which of the following properties specify whether the labels foran

element’s list items are positioned inside or cutside the “box” defined by the

listed ifem?

A. Hststyle
B, list-position

C. list-style-position
i

. list-position-style




32.

12

(3]

foreer 3 & w7 EgT e e A FRATE?

Which of the folowing does not generate 2 sp rite sheet?

A. SpritéRight.

B. Sprite Cow
C. (S8 Sprites
D. Glue

%’ﬁ'# g Fla T javascript ﬁﬂﬁfgﬁ ?{'ﬁ %"’

Which of the following is not a-javascript framework?
A. Vue

B. React

C. Node

D Laravel

e i & i o eg 9o FAREAEE javascript BEH AR TR
w1 e v R

‘Which of the following objects i the main entry point to all client-side

JavaScript features and APls?

A, QYsfere /Position
B. &Sy Window
C. TLUEE /Standard

D. et+er=i/Location

javascript#ergmmrrﬁm'm%?

Which JavaScript method is used to create a new array with array elements

that passes a test?

forEach()
map()
forMap()
filter()

o 0w

10
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"Ceeripilani” S&TIT =t & forw wdt fadaw §?

‘Which of the following is-the correct syntax to display "Ceeripilani" in an

alert box usirig JavaScript?
A. 'ale'ti't—'box("Ce’e'rip'il'ani "'_)_,j'
B. confirm("Céeripilani ");
C. msgbox("Ceeripilani "};
D

. ;aler_t("C.ée.ri_pik’:’an;i' -

VLOOKUP WS FI7T FIaT §7?

What does.the VLOOKUP function do?

A. 'v' T TFEE HY FreTaT §/Looks up text that contain v’
B, ST & B ey iFee v Sord S ft & T 6 arer e A $rChecks
whether text is the'same in-one-cell as in the next

¢, Hafla RFTS gaar §1/Finds related records

D -39UFa G f¥FeT/All of the above

What Pivot Table toolbar butten.updates the data.in a Pivot Table or Pivot
‘Chart Report if the source.data has changed?

A. Bife R Format Report.

B. 9 &&w /Pivot Table

C. R®BIUSEI Refresh Data

D. &7 f3&&/Show Detail

11




37.

38.

39.

To create an interactive Pivot Table for the web, you use 4 Microsoft Office

Web component called

A. HTML
B. R taa fres ¥ /Pivot Table Field List

C. e taw o /Pivot Table List

D. fge ¥aw o€ /Pivot Table Report

B2C &S Huforal a2 FrHa S0 & o PR aul dFae

Al of the following are techniques B2C ‘e-commerce companies tise to

attiact customers, except

A. R iCrSACTITE Hﬁs’ﬁﬂ ?Regis_te_ring with search en’g_ines-
B, arace AETEN/Viral marketing
C. Fferergr Rag=/Online ads

D, 'ﬁé’aﬁ FTHTET/ Virtual marketing

g & o Wi TER T AT REE AT 8

What type of ad-appears on topofa web page?

A, aT9-375< fAwT9=/pop-under ad
B. fa-3 BEmIe/pop-up ad
C. S=Taren [GT9st/ banner ad

D Eft-""ﬁ?iﬂmdiscount ad

12



FrEgETH ERIT R __FE A

A combination of soffware and information designed to provide security and

information for payment is.called a _

A. Rfaew aiac/digital wallet
B. Q93 ﬁ?n'q?ﬁpop—'up ad
C. TR HEs hopping cart

D. wiEcE fencryption

41. ﬂmgwﬁm#mgm%m#mmﬁ#ﬁﬁmww
Frg
Which one of the following statements is correct about Email security in the network
security methods?
H BT

One has to deploy har‘dWa-re_.; software, and security procedures to lock

those apps down.

B. 5= oo die o1l B seed s ey caagr St Rwar ¥ e T
Aeah & sgaer A R ot aoare, SedTe FY 3w o
One should know about what the normal behavior of a network look likes

S0 that he/she can spot any changes, breaches in the behavior of the

network.
Phishing is one of the most commonly used methods that are used by

hackers 1o gain access to the network

D. 39RIEd @Y RFew/Al of the above

13




42, Freah B 5T F B AT m?hzg-c:aﬁrm‘fthmm:gaﬁam%t

replicates jitself by creafing its own copies, in order to bring the

network to the hait.
A. Erst@/Trojan.
B. i/ Worm
C. TIgAY/Spyware
D, wifsra &/Logic bomb

43, WEH mmw%wwmmmmm @S #F e grar § AN
Sead BowER & W-%%aﬁaﬁrw-m%l

‘What is the name of attack whexn an atiacker is able to.eavesdrop on network traffic

and identify the MAC address.of a computer with network privileges?
A, ansERd) SFE/identity Theft
B. HAAZAST e swd® /Man in the midd'_le'a;tack
C. ﬁt‘d’é?mﬁf /Network Injection
p. uEEiEce valheE Accidental Association
a4, wraater 3w fag ot canRia R ST S oTE] R HARE Fras ik

A firewall is installed at the point-where the secure internal network and untrusted

g # ol S SR

external network meet which is also known a8 .
Al wtw Tﬁ%‘c’- /Choke point
B. ?ﬁ%ﬂﬁi%ﬂ'm_eéﬁng point
C. e 9ige /Firewall point

D. =TT 95T /Secure point
14



45. RrrTafa & & o v e weelE ¥ S Rl g & v sifaw
SETEOT AT FEHE B HE FrEAl g AT we F Y wegEhy &y
Which one of the following is a kind of technique that allows sharing the single

physical instance of an application orthe resources among.mu'l'ti_pie

organizations/customers?.

A. REITISUT /Virtualization

B. ¥iw-afwes m /Service-Oriented Architecture
C.. ﬁ's'?ﬁfﬁf\ﬁ?T /Grid Computing

D. FRf&Er swgfean/utility Computing.

46, RrafAfRa § @ wlF @r ena AT @reegF) AR AT vae S €7
Which one of the following given programs provides isolation (abstraction) and

partitioning?

A. Wg‘]‘é‘tﬂﬁm /System hypervisor

'B. GIFcIgT gSULiaai} /Software hypervisor
C. FI8aIT BT aw/Hardware hypervisor
D. ﬁ@aﬁmm BIEURITSI /Virtualization hypervisor

47, eefaf@a # @ wlg o # a7 & fav a7
‘Which of the following is a valid for loop in Python?
« for(i=0; i <'m; i++)

for i in range(0,5):

for i in range(0,5)

U 0w o

for iin range(s)

15




48.

49.

50.

M@ﬁwmmsﬁgﬁﬁﬁvgﬂmwmmmﬂm%

To add a new clement to a list we use which:Python command?

A, lstl.addEnd(5)
B. fist1.add}.ast(5)

C. 'iistl.append_(:’p)-
D. Tist1.add(5).

FXATR?

Tn which part of memory does the sysicm store the parameter and local variables

of function call?

A. ET9/heap
R, T&&H/Stack
¢. e YA C/Data segment

D. ?ﬁ{{Q ugue

rarerer 3 R e 1 G A W FEl S T

Which function is called an anonymous finetion in Python?

A. S§Fs8T/Liambda
B. ﬁ'q /map
C. .i%va‘!ﬁlter'

D. RZgF/reduce

16



